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Applicable Regulations
This section contains important information about regulatory clearance and
usage of SyMRI. Note that SyMRI is classified as a medical device (MD) and is
therefore subject to regulation that applies for clinical and non-clinical use.
For instance, in the European union the Medical Device Directive (MDD) ap-
plies.

SyMRI may only be used if and when legally permitted, check with local au-
thorities and SyntheticMRAB if uncertain if this version of SyMRI can be legally
used by you in your domain.

WARNING: If the regulatory domain that applies for you is not listed in
this section SyMRI may not be used for any other purpose than demon-
stration or investigation as a non-medical device and shall not be used
for diagnosis or any kind of patient management purposes.

The marking “Medical Regulations Apply (Page I)” on each page of this man-
ual is a reference to this section for further details.

Certified Use

SyMRI complies with the following regulatory requirements. Usage is subject
to local law and the conditions of the regulations. Additional restrictions,
conditions or regulations may apply.

• CE (European Union):
SyMRI 11 is a CE-marked medical device that complies with the Council
Directive 93/42/EEC (MDD). 0413

• USA/HSS (FDA): SyMRI 11 is an FDA 510(k) cleared medical device,
K191036. Rx only.

• Australia (Therapeutic Goods Administration, TGA):
For the Australian market the regulatory sponsor is:

Emergo Australia
201 Sussex Street, Level 20, Tower II Darling Park
Sydney, NSW 2000
Australia

Not For Clinical Use (NFCU)

This section lists domains in which SyMRI may under certain restrictions be
used in a non-clinical setting (NFCU). For domains where NFCU usage may
apply, pay attention to the warning text that applies and any additional re-
strictions, conditions or regulations that may apply.

• Canada and the countries where Health Canada regulations is appli-
cable:

Investigational Device - To Be Used by Qualified
Investigators Only
Instrument de recherche - Réservé uniquement à
l’usage de chercheurs compétents
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Incident Reporting
In case of a serious incident, please contact the applicable representative,
sponsor, and/or regulatory body that is applicable to the regulations where
you have purchased and use SyMRI.

A complete list and additional legal information can be found at the following
site:
https://www.syntheticmr.com/legal

Patents and Trademarks
SyntheticMR AB’s unique technology supports a faster MR imaging work-
flow and allows users to follow disease progression and therapy efficacy with
greater confidence. A single 6-minute scanning sequence measures the ab-
solute properties of the brain and delivers up to 8 different contrast weighted
images, automatic segmentation and volumetric measurements of the pa-
tient. SyntheticMR AB is leading the way to a faster and more precise diag-
nosis of patients worldwide which has resulted in a patent portfolio covering
many important innovations within synthetic MRI.

Please refer to the following page for an up-to-date listing of the applicable
patent and trademarks, and additional legal information:
https://www.syntheticmr.com/legal

II
SyMRI® Medical Regulations Apply (Page I)

https://www.syntheticmr.com/legal
https://www.syntheticmr.com/legal


Contents
Applicable Regulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I

Certified Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I
Not For Clinical Use (NFCU) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . I

Incident Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . II
Patents and Trademarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . II

Contents ................................................... II
1 Introduction .............................................. 1

1.1 Device Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.2 Intended Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.2.1 Indications for use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.3 Advantages of SyMRI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.4 Abbreviations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.5 Warnings, Cautions and Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

1.5.1 Note . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.5.2 CAUTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.5.3 WARNING . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Part I - Work with SyMRI® ................................ 6

2 Deployments of SyMRI .................................. 8
2.1 SyMRI for Sectra PACS IDS7 (Plug-In) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2.1.1 Starting and Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.2 SyMRI StandAlone for Microsoft Windows . . . . . . . . . . . . . . . . . . . . . . 10

2.2.1 Starting and Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.3 SyMRI StandAlone for macOS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

2.3.1 Starting and Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
2.3.2 Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

2.4 SyMRI for Network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
2.4.1 Starting and Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

2.5 SyMRI for syngo.via OpenApps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
2.5.1 Starting and Exiting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

3 Concepts and Functions ................................ 14
3.1 Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.1.1 Package . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
3.2 Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

3.2.1 Viewport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.3 Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.4 Options and Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

3.4.1 Layout Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.4.2 View Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.4.3 Other . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

3.5 Viewing Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
3.5.1 Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
3.5.2 Navigate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
3.5.3 Windowing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

4 Optional Tools and Features ............................ 21
III

SyMRI® Medical Regulations Apply (Page I)



4.1 AutoROI Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
4.1.1 Functionality Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

4.2 Distance Measurement Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
4.3 Quantification Table (Q-Table) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

4.3.1 Displaying the Quantification Table . . . . . . . . . . . . . . . . . . . . . . 24
4.3.2 Information in the Quantification Table . . . . . . . . . . . . . . . . . 24

Part II - SyMRI® IMAGE ................................. 24

5 Functions in SyMRI IMAGE .............................. 26
5.1 Synthetic Contrast Weighted Images . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5.1.1 Display of Synthetic Contrast Weighted Images . . . . . . . . . . 27
5.1.2 Adjusting the Image Contrast . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
5.1.3 Adjusting FLAIR Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
5.1.4 Adjusting Double IR Images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
5.1.5 Navigation Window for Contrast Images . . . . . . . . . . . . . . . . 30

5.2 SyMaps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
5.2.1 Display of SyMaps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5.3 Region of Interest (ROI) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
5.3.1 Create and Adjust ROI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
5.3.2 Information in ROI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
5.3.3 ROI Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
5.3.4 Functions on a ROI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

5.4 Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
5.5 Save and Load . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

5.5.1 Save SyMaps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
5.5.2 Save a Screenshot of the Workspace . . . . . . . . . . . . . . . . . . . . 38
5.5.3 Save Image Stacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Part III - SyMRI® NEURO ................................ 39

6 Functions in SyMRI NEURO ............................. 41
6.1 The Intracranial Mask . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

6.1.1 Adjusting the Intracranial Mask . . . . . . . . . . . . . . . . . . . . . . . . . . 42
6.1.2 Additional Functions for the Intracranial Mask . . . . . . . . . . . 43

6.2 Tissue Segmentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
6.2.1 Brain Parenchyma and CSF Segmentation . . . . . . . . . . . . . . . 44
6.2.2 Myelin Correlated (MyC) Partial Volume Mapping . . . . . . . 44

6.3 Segmentation Maps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
6.3.1 Display Segmentation Maps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
6.3.2 Background Image for Segmentation . . . . . . . . . . . . . . . . . . . 48

6.4 User Mask for User Defined Segmentation . . . . . . . . . . . . . . . . . . . . . 49
6.4.1 Display the User Mask . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
6.4.2 Measuring Volume Using the User Mask . . . . . . . . . . . . . . . . 49
6.4.3 Create and Adjust User Mask . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
6.4.4 Save and Load the User Mask . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

6.5 Segmentation Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
6.5.1 Displaying Volumes per Slice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
6.5.2 User Mask in the Segmentation Table . . . . . . . . . . . . . . . . . . . 53
6.5.3 Exporting the Segmentation Table . . . . . . . . . . . . . . . . . . . . . . 53

6.6 Reference curves . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
IV

SyMRI® Medical Regulations Apply (Page I)



6.7 ROI in SyMRI NEURO . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
6.7.1 Measuring the Volume of Segmented Tissue . . . . . . . . . . . . . 55

6.8 Plots in SyMRI NEURO . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Part IV - Important Information ........................ 56

7 Warnings ............................................... 58
7.1 Image Artifacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

7.1.1 Motion Artifacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
7.2 Deviations - Synthetic MRI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.2.1 Black Blood . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
7.2.2 Flow Sensitivity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
7.2.3 Small Features Might Disappear . . . . . . . . . . . . . . . . . . . . . . . . . 59

7.3 Functions Specific for Synthetic MRI . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
7.3.1 Use ROI to Null Tissue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
7.3.2 Quantitative Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
7.3.3 Segmentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
7.3.4 Factors Affecting the Volume Estimations . . . . . . . . . . . . . . . 63

7.4 Additional Warnings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
7.4.1 System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
7.4.2 Follow-up Examinations Using Different Analysis Tools . . 66
7.4.3 Character Encoding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
7.4.4 Anonymization Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

7.5 Scanner Specific Warnings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
7.5.1 GE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
7.5.2 Philips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
7.5.3 Siemens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Part V - Appendix ....................................... 68

8 Keyboard Shortcuts .................................... 70

V
SyMRI® Medical Regulations Apply (Page I)



1 Introduction

1.1 Device Description
SyMRI allows the user to generate multiple image contrasts from a single
acquisition scan. This is accomplished by post-processing a multi-delay,
multi-echo acquisition (MDME) into parametric maps. The parametric
maps are R1, R2 relaxation rates, and proton density (PD). The inverse
relaxation parameters, T1 relaxation time (1/R1), and T2 relaxation time
(1/R2) are also provided as parametric maps. The parametric maps can be
visualized as contrast weighted MR images, such as T1-, T2-, PD, and
Inversion Recovery (IR) weighted images (including T1W FLAIR, T2W FLAIR,
STIR, Double IR, and PSIR weighted images). SyMRI calculates the pixel
signal intensity as a function of R1, R2, PD, and desired MR scanner settings,
such as echo time (TE), repetition time (TR), and inversion delay time (TI).
A number of default settings for TE, TR, and TI are provided, but the user
has the ability to change the contrast of the images. SyMRI generates all
the different image contrasts from the same parametric maps, derived
from the same acquisition. This leads to enhanced image slice registration,
owing to the absence of inter-acquisition patient movement. SyMRI
provides the user the ability to change the contrast of the images after the
acquisition. This is performed by adjusting the TE, TR, and/or TI parameters
post-acquisition, to generate the specific contrast desired.

SyMRI also enables the users to obtain volumetric information in the head,
including white matter (WM), grey matter (GM), cerebrospinal fluid (CSF),
Myelin correlated (MyC) partial volume, brain parenchyma (BP) and
intracranial cavity (IC). This is accomplished by using tissue definitions
based on the parametric maps. The tissue definitions provide tissue partial
volume, or tissue fraction, per voxel. SyMRI also provides image processing
tools to extract the values of the parametric maps, and tissue partial
volume, per individual pixel, per region of interest, or the entire imaging
volume.

SyMRI is intended to be used on data produced by any of the following
acquisition sequences:

• MDME sequence data from GE MAGiC

• MDME sequence data from Philips SyntAc

• MDME sequence data from Siemens 3 T TSE_MDME

• MDME sequence data from Siemens 1.5 T TSE_MDME1

1 Not yet 510(k) cleared by the US FDA and thus currently not available for sale in the US unless limited to research or investigational use
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1.2 Intended Use
1.2.1 Indications for use

SyMRI is a post-processing software medical device intended for use in
visualization of the brain. SyMRI analyzes input data from MR imaging
systems. SyMRI utilizes data from a multi-delay, multi-echo acquisition
(MDME) to generate parametric maps of R1, R2 relaxation rates, and proton
density (PD). SyMRI can generate multiple image contrasts from the
parametric maps. SyMRI enables post-acquisition image contrast
adjustment. SyMRI is indicated for head imaging.

SyMRI is also intended for automatic labeling, visualization and volumetric
quantification of segmentable brain tissues from a set of MR images. Brain
tissue volumes are determined based on modeling of parametric maps from
MDME images.

When interpreted by a trained physician, SyMRI images can provide
information useful in determining diagnosis. SyMRI should always be used in
combination with at least one other, conventional MR acquisition (e.g. T2W
FLAIR).

1 INTRODUCTION 2
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1.3 Advantages of SyMRI
SyMRI only uses a single acquisition to obtain R1, R2 and PD values.
Synthetic T1W, T2W and FLAIR images with any choice of echo time TE,
repetition time TR and inversion delay time TI can be shown without the
need to rescan the patient. Therefore, the method can save valuable scan
time for the MR examination.

CAUTION: The synthetic T2W FLAIR shows an edge-enhancement effect
at the interface of CSF and brain tissue. It is the result of partial volume
effects of the acquisition voxels at the interface.

Use of the synthetic T2W FLAIR contrast depends on the clinical question.
The synthetic T2W FLAIR has an excellent sensitivity for changes in brain
tissue.

CAUTION:We recommend that any changes visible in T2W FLAIR are
confirmed using the T2W, PDW, PSIR or Double IR of the same synthetic
dataset.

Since all synthetic contrast weighted images are generated from the same
parametric maps, from the same acquisition, the synthetic images will be
registered. This means that a finding in T2W FLAIR will appear in the exact
same pixel in the other synthetic contrast weightings (T2W, PDW, PSIR or
Double IR) for confirmation or rejection as a false positive.

CAUTION: For diagnosis of illnesses resulting in edge-enhancements in
the T2W FLAIR, such as inflammatory reactions or hemorrhages, the
synthetic sequence alone may not be sufficient for diagnosis. In case of
doubt, the addition of for example a conventional 3D-FLAIR is
recommended.

WARNING: Patient management decisions should not be made based
solely on synthetic contrast weighted images from SyMRI and should al-
ways be used in combination with conventional MRI or other diagnostic
tools applicable.

The tissue segmentation features provide quantitative measures. This can
support objective assessment of the patient. Multi-slice imaging and
enhanced processing techniques using the SyMRI software generates a
three- dimensional volumetric quantification of brain, CSF, WM, GM, MyC
and total intracranial volumes.

This user manual provides an overview of available functionality and
describes all concepts used in the software.

1 INTRODUCTION 3
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1.4 Abbreviations
The following abbreviations are used in the manual.

BPV The Brain Parenchymal Volume; the volume of all tis-
sues in the ICV excluding the CSF volume

BPF The Brain Parenchymal Fraction, the BPV divided by
the ICV

CSF SyMRI’s definition of Cerebrospinal Fluid (see Section
6.2)

DIR Double IR, an inversion recovery image with two in-
version times

FLAIR FLuid Attenuated Inversion Recovery, an MR image
where the signal from CSF is suppressed

GM SyMRI’s definition of gray matter (see Section 6.2)

HUD Heads-Up Display; the information presented along-
side an image in SyMRI, like patient- and image in-
formation

ICV Intracranial Volume; the total volume of the Intracra-
nial mask

IR Inversion Recovery; imaging where an inversion pre-
pulse is applied.

MRI Magnetic Resonance Imaging

MyC SyMRI’s tissue definition that correlates with Myelin

Non-WM/GM/CSF Tissue with characteristics which deviate from WM,
GM and CSF (see Section 6.2)

PD The proton density

PDW An image with PD-weighted contrast, typically short
TE and long TR

PSIR Phase Sensitive Inversion Recovery, an image with in-
version recovery where the signal sign is kept

R1 The longitudinal R1 relaxation rate (1/T1)

R2 The transverse R2 relaxation rate (1/T2)

ROI Region of Interest; a user-defined region in one slice
in the data set, drawn with a dedicated ROI-tool

STIR Short T1 IR image, a fat suppression technique

SyMaps A map that shows one of the quantitative values T1,
T2, R1, R2 or PD

T1 The longitudinal T1 relaxation time (1/R1)

T1W An image with T1-weighted contrast, typically short
TE and short TR

T2 The transverse T2 relaxation time (1/R2)

T2W An image with T2-weighted contrast, typically long
TE and long TR

TE The echo time

TI The inversion delay time after an inversion pulse
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TR The repetition time

UM User Mask, see Section 6.4

WM SyMRI’s definition of (myelinated) white matter (see
Section 6.2)
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1.5 Warnings, Cautions and Notes
1.5.1 Note

Notes contain important information about features in SyMRI that needs to
be highlighted. Information presented as Notes includes helpful tips,
specific limitations to the availability of certain functions, as well as
highlighting behavior in SyMRI that may not be intuitive to the user.

Note: Example of a note

1.5.2 CAUTION

Cautions indicate potentially hazardous situations for the patient or user
that could result in lost time, reduced image quality and/or the patient
having to be re-examined. Cautions also indicate how such situations are
avoided.

CAUTION: Example of a caution

1.5.3 WARNING

Warnings indicate potentially hazardous situations that could result in injury
for the patient, mainly in the form of misinterpretation and misdiagnosis.
Warnings also indicate how such situations are avoided.
The ISO 15223-1:2016 warning symbol is used with these warnings to
highlight the importance of the warning.

WARNING: Example of a warning
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2 Deployments of SyMRI
SyMRI is available in several deployments, depending on your system and
licensing one or more deployment modes are available.
Please consult your system administrator or manager for queries on which
deployments are available for your use.

Most functionality, behavior and user interface interactions are identical
across all deployments whereas some aspects differ slightly. The following
chapters of this part of the user manual describes the differences and some
particulars of the deployments.
In some places in the other parts of the user manual there are sections that
only apply to one of the deployments. These sections are marked with a
margin note and a vertical bar in the following manner:

Plug-In This paragraph only applies to SyMRI for Sectra PACS IDS7 (Plug-In).

StandAlone This paragraph only applies to SyMRI StandAlone.

Windows This paragraph only applies to SyMRI for Microsoft Windows.

macOS This paragraph only applies to SyMRI for macOS.

Network This paragraph only applies to SyMRI for Network.
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2.1 SyMRI for Sectra PACS IDS7 (Plug-In)
When SyMRI is used as a plugin in Sectra PACS IDS7 the application toolbar
and menu are placed in a floating toolbar window instead of attached to
the main window. The floating toolbar can be freely moved at your
discretion.
The workspace with the floating toolbar can be seen in Figure 2.1.

Figure 2.1: The workspace in SyMRI with a floating toolbar.

2.1.1 Starting and Exiting

This chapter describes how to start SyMRI on a Sectra IDS7 workstation.

2.1.1.1 Start SyMRI

• Start and log on to Sectra IDS7.

• Open desired image stack in a Sectra IDS7 image window.

• Select “SyMRI” in the clinical application menu.

• SyMRI starts and can be used.

In the event of non-recoverable errors during loading, SyMRI will terminate
and return to Sectra PACS IDS7 after displaying a message box with
information about the error.

2.1.1.2 Close SyMRI

SyMRI is closed by using the menu item File›Exit SyMRI in the floating
toolbar (see Section 3.3).
Do not close the Sectra image window before exiting SyMRI since it can
cause incorrect termination of SyMRI.
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2.2 SyMRI StandAlone for Microsoft Windows
2.2.1 Starting and Exiting

This chapter describes how to start the StandAlone deployment of SyMRI.

2.2.1.1 Start SyMRI

• Start the SyMRI stand-alone program.

• Click on the main window background and select the desired dataset.

• SyMRI starts and can be used.

In the event of a dataset related error during loading, SyMRI will return to
the main window where you can click to start on a different dataset after a
message box with information about the error has been displayed. If the
error is not recoverable, SyMRI may exit after displaying the error message.

2.2.1.2 Close SyMRI

SyMRI can be closed using the menu item File›Exit SyMRI in the toolbar (see
Section 3.3) or by pressing the main window’s close button.
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2.3 SyMRI StandAlone for macOS
2.3.1 Starting and Exiting

This chapter describes how to start the StandAlone deployment of SyMRI.

2.3.1.1 Start SyMRI

• Start the SyMRI stand-alone program.

• Click on the main window background and select the desired dataset.

• SyMRI starts and can be used.

In the event of a dataset related error during loading, SyMRI will return to
the main window where you can click to start on a different dataset after a
message box with information about the error has been displayed. If the
error is not recoverable, SyMRI may exit after displaying the error message.

2.3.1.2 Close SyMRI

SyMRI can be closed using the menu item SyMRI›Exit SyMRI in the menubar
(see Section 3.3) or by pressing the main window’s close button.

2.3.2 Keyboard Shortcuts

On macOS the following shortcut keys are different from Windows:

• instead of Ctrl.

• F13 instead of Insert.
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2.4 SyMRI for Network
2.4.1 Starting and Exiting

This chapter describes how SyMRI is used in networking mode.

2.4.1.1 Start SyMRI

• Start SyMRI from PACS.

• Depending on if a single series or a study has been selected, a list of
series which can be loaded is presented.

• If there are saved user masks or intracranial masks, one of these may
be selected after the series has been loaded from the network.

In the event of non-recoverable errors during loading, SyMRI will terminate
after displaying a message box with information about the error.

2.4.1.2 Close SyMRI

SyMRI can be closed using the menu item File›Exit SyMRI in the toolbar (see
Section 3.3) or by pressing the main window’s close button.
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2.5 SyMRI for syngo.via OpenApps
2.5.1 Starting and Exiting

This chapter describes how SyMRI is used in syngo.via OpenApps.

2.5.1.1 Start SyMRI

• Start SyMRI from syngo.via OpenApps. See the User Manual for
syngo.via OpenApps for more information.

• If a series has previusly been opened with SyMRI, double click on the
series for syngo.via OpenApps to automatically start SyMRI with the
series.

In the event of non-recoverable errors during loading, SyMRI will terminate
after displaying a message box with information about the error.

2.5.1.2 Close SyMRI

SyMRI can be closed by pressing the tab’s close button. See the User
Manual for syngo.via OpenApps for more information.
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3 Concepts and Functions
This chapter describes general concepts, functions, user commands and
functions accessible in all packages within SyMRI. Specific functionality for
each separate package is covered in the following chapters.

3.1 Concepts
3.1.1 Package

There are two packages available in SyMRI, SyMRI IMAGE (Chapter 5) and
SyMRI NEURO (Chapter 6). Depending on your licensing one or more of
them are available for use.
When a dataset has been loaded, the active package can (if your licensing
permits) be changed via the menu item Preferences›Switch Package.

3.1.1.1 SyMRI IMAGE

The SyMRI IMAGE package is available with an IMAGE or NEURO license. See
Chapter 5 for a description of the SyMRI IMAGE package and its
functionality.

3.1.1.2 SyMRI NEURO

The SyMRI NEURO is only available with a NEURO license and will
automatically be selected when a brain dataset is loaded and classified as a
brain (the text: “Recognized Object: Brain” appears on the left side of the
image).
If the dataset is classified as another anatomy/object, the SyMRI IMAGE
package will be selected instead. You can change to SyMRI NEURO using
the menu item Preferences›Switch Package.
SyMRI NEURO contains all features of SyMRI IMAGE, but also provides
automatic tissue segmentation, volume calculations and
BPF-measurement. See Chapter 6 for a description of the SyMRI NEURO
package and its functionality.
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3.2 Workspace
The complete window covered by SyMRI is called the workspace. The
workspace (Figure 3.1) includes one or several viewports with images or
tables.
The workspace is controlled by using the SyMRI menu and toolbar (section
3.3). The keyboard and mouse can also be used.

Figure 3.1: The workspace in SyMRI configured with six viewports. The contents in
the toolbar and menus depend on the current package and your licensing.

3.2.1 Viewport

Each separate image or table within the workspace of SyMRI is called a
viewport. Each viewport can display one image with image information
(Figure 3.2), or (if your licensing permits) a table of tissue volumes. The
viewport where the mouse pointer is placed is always active. The viewport
content is controlled by the right-click menu.

Figure 3.2: Two viewports in the SyMRI workspace. When a ROI is active,
additional information is displayed on the right side of the viewport.
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3.2.1.1 Viewport Image Information

The viewport image information can also be referred to as the “HUD”
(Heads-Up Display). The information displayed in the HUD depends on
what type of image is shown in the viewport.
Patient information: The patient information is displayed in the upper left

corner and includes patient name, ID, age, and gender.
Examination information: The examination information is displayed in

the upper left corner, below the patient information. Protocol name,
acquisition date and time is displayed, and if applicable, information
about administered contrast agent.

Note: If any of the displayed information is missing from the data set, e.g.
due to anonymization, the line usually displaying this data will be
completely removed from the HUD and the subsequent lines will be moved
up so that no empty space is visible.

WARNING: Information about the contrast agent/bolus is shown only if
the dataset contains the DICOM tag that indicates that a contrast agent
or boluswas used in the scanning. When this tag is present, a line starting
with “Contrast:” is shown. If the tag is present but has no value, the line
will be “Contrast: Yes”. If the tag has a custom value, the custom value
will be displayed instead of Yes. When this DICOM tag is not present,
meaning that no contrast agent/bolus was used, the contrast/bolus line
is not shown.

Acquisition geometry: The acquisition geometry is displayed in the
bottom left corner of the viewport. This includes FOV, slice thickness,
slice gap, number of slices and the position of the current slice.

Zoom and Windowing: The current zoom, as well as the center and width
of the windowing is displayed in the upper right corner.

Information on contrast weighting is only visible in viewports where a
contrast weighted image is displayed.
Contrast weighting information: The contrast weighting information is

displayed in the upper left corner, below the Examination
information, and at the top of the viewport. The information to the
left contains the scanner parameters, like TE, TR, etc. (Section 5.1).
The current contrast weighting is written at the top of the viewport.

Navigation window: The navigation window appears below the text in the
upper left corner. (Section 5.1.5)

There is also some information that is only displayed when a ROI is active in
a viewport (Section 5.3).
ROI info: Statistical information about the ROI appear in the upper right

corner, below the Zoom and Windowing information. It contains
information about the tissue properties within the ROI, as well as the
signal intensity (Section 5.3.2).

ROI plot: A scatter plot also appears in the bottom right corner of the
viewport (Section 5.4).

Some additional information may be displayed when using a SyMRI NEURO
license (Section 6).
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3.3 Toolbar
The commands available in the SyMRI toolbar target the entire workspace
rather than one specific viewport. The contents in the toolbar and menus
depend on the current package and your licensing. For example, language
and workspace settings are found in the toolbar, along with functions for
exporting entire datasets and screenshots.
The availability of some features depends on your licensing.

Figure 3.3: The toolbar in SyMRI. The upper is the toolbar for SyMRI NEURO with
the AutoROI Tool. The lower is the toolbar in SyMRI IMAGE.

The specific commands in the toolbar and on the right-click menu are
described in the following sections.

Plug-In Note: Even though SyMRI is integrated in Sectra IDS7, it is a separate pro-
gram. The tools available in the Sectra IDS7 application can NOT be used
in SyMRI and vice versa. Only the tools on the SyMRI floating toolbar are
applicable to SyMRI.
Pressing the close button or closing the Sectra IDS7 main window with-
out exiting SyMRI may cause SyMRI to terminate incorrectly or leave the
floating toolbar window accessible until a new patient or examination is
selected.

macOS In macOS the menubar is found at the top of the screen when SyMRI is in
focus.
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3.4 Options and Preferences
3.4.1 Layout Options

The number of viewports can be changed.

View›1 Viewport «Ctrl+1» Show one viewport
View›2 Viewports «Ctrl+2» Show two viewports
View›3 Viewports «Ctrl+3» Show three viewports
View›4 Viewports «Ctrl+4» Show four viewports
View›5 Viewports «Ctrl+5» Show five viewports
View›6 Viewports «Ctrl+6» Show six viewports
Viewport layouts, including the settings of each viewport, can be saved and
loaded.
Preferences›Save Current Layout Save current layout with number of
viewports, time parameters, overlay type, type of SyMaps and image
settings. When saving the layout, a dialog box asking for a name of the
layout is shown.
If there are any saved layouts, SyMRI will select one as start-up layout
whenever SyMRI is started. Which layout is selected depends on three
criteria:

1. Acquisition orientation
2. Recognized object
3. Field strength

If no exact match can be found, the closest match will be selected by
matching the criterias in the order specified above.
Preferences›Load Layout Load a saved layout. Each saved layout is an
item in a submenu with the name given when saving the layout. Selecting
one of the items loads that layout. This layout will be used as default layout
when starting SyMRI.
Preferences›Delete Layout Delete a saved layout. Each saved layout is an
item in a submenu with the name given when saving the layout. Selecting
one of the items deletes that layout.

3.4.2 View Options

View›Link Zoom and Pan All viewports in the workspace are linked. The
pan and zoom will be adjusted simultaneously in all viewports. This will
make the zoom and pan identical for all images.
View›Bicubic interpolation «Ctrl+P» Interpolation gives a smoother
visualization of contrast weighted images and SyMaps. Interpolation of
images is active by default and is always linked between all viewports. This
setting is not affected by, and does not effect, View›Link Zoom and Pan.

Note: Zooming out far while interpolation is turned off may cause aliasing
artifacts in the image.

Right-Click›Image Settings›Color «C» When the color option is activated,
the image stack is displayed in color instead of grayscale. Synthetic
contrast weighted images cannot be visualized in color. (See Section 6.3.2.)
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3.4.3 Other

Preferences›Language Choose desired language from the list of available
languages. When any language other than English is used the menu item
always contains the text “(Language)” (in English) after the word for
language in the currently chosen language. The sub-menu contents are the
names of each available language, written in that language.

Windows File›About SyMRI Information about the currently running version of
SyMRI will be displayed.

macOS SyMRI›About SyMRI Information about the currently running version of
SyMRI will be displayed.
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3.5 Viewing Images
3.5.1 Zoom

Zoom Tool «Z» Moving the mouse while keeping the left mouse button
down will zoom the image stack in the viewport. Movement forward zooms
in and movement backward zooms out. Tables and plots cannot be
zoomed.
Right-Click›Zoom›Zoom in «Ctrl+Z» The image is zoomed in one step.
Right-Click›Zoom›Zoom out «Ctrl+Shift+Z» The image is zoomed out
one step.

The zoom steps are predefined.

Right-Click›Zoom›Zoom to Fit Window The size of the image is adjusted
to the size of the viewport.
Right-Click›Zoom›Pixel to Pixel One voxel in the original DICOM-dataset
is displayed using one pixel on the computer screen. For non-square voxels
the shortest side of the voxel in the image plane is mapped to one pixel on
the computer screen.

3.5.2 Navigate

Scroll through image stack: Scroll through the image stack by scrolling
the mouse wheel or using the «Page Up» and «Page Down» keys. The
first slice of an image stack is reached through «Home». The last slice
is reached through «End».

The following tools can be found in the SyMRI toolbar.

Paging Tool «F4» Moving the mouse while keeping the left mouse button
down will scroll through the image stack.
Pan Tool «F5» «P» Moving the mouse while keeping the left mouse button
down will pan the image stack in the viewport. Tables and plots cannot be
panned.

3.5.3 Windowing

Windowing: Keep the middle mouse button or mouse wheel down and
move the mouse to adjust the contrast and intensity of the image.
Horizontal movement will change the window centre and vertical
movement changes the window width. The centre and width will
determine the gray- or color-scale of the image, which in turn
affects brightness and contrast.

Right-Click›Image Settings›Auto Scale «A» The image brightness and
contrast is set to suit the image in the viewport.
Right-Click›Image Settings›Invert Grayscale «Ctrl+Shift+I» When the
inverted grayscale option is activated, the image stack is displayed with the
intensity of each pixel inverted i.e. black pixels are displayed as white and
vice versa.
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4 Optional Tools and Features
The availability of these optional tools may depend on your choice of
licensing, please contact your sales representative for inquiries about
purchasing optional features.

4.1 AutoROI Tool
A tool that combines and enhances functions of the ROI and user mask for
quicker manual segmentation.
The ROI and user mask created by AutoROI Tool has the same properties
and basic functionality as those created with the basic ROI and user mask
functionality. See sections 5.3 and 6.7 for more details on basic ROI
operations and features, and section 6.4 for the User Mask.

Figure 4.1: A screenshot of lesions segmented using the AutoROI Tool.

Note: The AutoROI Tool does not make any pathological classification of the
selected features. Clinical competency is required for correctly assessing the
characteristics of the ROI and adjusting the generated user mask if needed.
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4.1.1 Functionality Description

The AutoROI Tool is intended to facilitate and make manual segmentation
of features and structures in the brain easier and less time consuming.

AutoROI Tool «X» Click or draw to add or remove regions to or from the
user mask.

Toggle add/remove mode: «X» When the AutoROI Tool is active, toggle if
the AutoROI Tool should add to or remove from the user mask.

To activate the tool, click the AutoROI Tool icon in the toolbar or press «X»
once. Pressing «X» after the tool has been activated will toggle between
adding to the user mask and subtracting from the user mask. The tool is
initially in the adding mode when enabled, when in the subtractive mode
the mouse cursor changes with an minus sign indicating the subtractive
mode (also see table 4.1).

Table 4.1: AutoROI Tool cursor for the two modes of operation.

Cursor Icon AutoROI Mode

Adding mode

Subtracting mode

4.1.1.1 Draw Functionality

A ROI of free shape can be drawn in the same way as a freehand ROI
(section 5.3.1). When the ROI is drawn on a contrast weighted image, the
contained pixels are automatically added to the user mask.
When the ROI is drawn on a segmentation overlay, the ROI will contain the
selection within the overlay map, thus selecting only within the values
segmented as the selected tissue/fluid.
In the addition mode the region is added to the user mask, and conversely
in the subtractive mode, the region is subtracted from the user mask.

4.1.1.2 Click Functionality

When the AutoROI Tool is used to click on features on contrast weighted
images or segmentation overlay, the feature is automatically segmented
and added to the user mask. A ROI is created around the segmented
region. If the segmented region overlaps with existing user mask the ROI is
created around the whole region.
In the addition mode the region is added to the user mask, and conversely
in the subtractive mode, the region is subtracted from the user mask.
Note that when used on contrast weighed images, the functionality is
primarily designed for easier selecting findings such as MS-lesions 1 and
other small morphological changes. For larger morphological changes
additional clicks may be required to sufficiently cover the entire morphology
of interest.

1 Additional manual adjustments of the selection might be required.
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When used on a segmentation overlay, the function is primarily designed
and optimized for ventricle segmentation. The tool can be used on any
segmentation overlay available but might have less optimal behavior.

4.2 Distance Measurement Tool
The Distance Measurement Tool is a tool to measure the distance between
the center of two voxels within a slice. It is activated by selecting the icon
in the toolbar.
A distance is measured by placing the mouse pointer on the start point in
the viewport, holding down the left mouse button and moving the pointer
to the endpoint, and finally releasing the left mouse button. The distance is
shown as a line with two endpoints and the distance in mm printed. The
distance can be moved afterwards by holding down the left mouse button
with the mouse pointer on the line and moving it. The distance can also be
changed by moving only one of its endpoints by holding down the left
button with the mouse pointer over one of the endpoints and moving it.
Right clicking on a distance activates a context menu:
Right-Click›Disable Distance Remove the distance clicked on.
Right-Click›Disable All Distances Remove all distances in the current
viewport.

Figure 4.2: An example of using Distance Measurement Tool.
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4.3 Quantification Table (Q-Table)

Figure 4.3: An example of the Quantification Table on a dataset with a user mask.

4.3.1 Displaying the Quantification Table

To display the Quantification Table, right-click and select “Quantification
Table”.

4.3.2 Information in the Quantification Table

The Quantification Table is intended to give additional information about
the quantitative values in WM, GM, Brain and User Mask. “Brain” is the
brain parenchyma, the combination of WM, GM, and NON.
Values displayed are mean and standard deviation of T1, T2, R1, R2, and PD
within the segmented tissues. The total volumes are also displayed. Unlike
the Segmentation Table, the Quantification Table doesn’t display individual
slices. The user mask can be used to display the tissue values in chosen
regions of one or several slices. See section 6.4 (User Mask for User Defined
Segmentation) in the user manual for information about how to use the
user mask. This section also describes how to copy a segmented tissue,
such as CSF or myelin, to the user mask and thereby adding an additional
tissue to the Quantification Table.
A larger version of the Q-plot is also displayed. The axis of the Q-plots can
be changed to R1-PD and R2-PD in the same way as the regular Q-plot.
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5 Functions in SyMRI IMAGE
In SyMRI IMAGE the functionality to perform Synthetic Magnetic Resonance
Imaging is available. The approach uses a single MR quantification scan to
measure the tissue properties R1 and R2 relaxation rates and proton density
PD. Based on these three properties contrast weighted images such as T1W,
T2W or FLAIR can be synthesized with a free choice of echo time TE,
repetition time TR, in case of an inversion pulse, inversion delay time TI, and
in case of a double inversion pulse, a second inversion delay time TI2.
Default settings for common contrast weighted images are provided but
the user may alter TE, TR, TI and TI2 to any possible value.

CAUTION: The synthetic images are acquired and calculated differently
than actual conventional images and therefore the image contrast is
very similar, but not necessarily identical, even at the same settings for
TE, TR and TI. Take your time to find a setting of TE, TR and TI such that
either the appearance of the images is similar to those you are
accustomed to, or optimized according to your needs.
Interpretation of synthetic images should be done with care and an
educational period to learn the nuance differences between synthetic
and conventional images is recommended.

Figure 5.1: When SyMRI IMAGE is started, six viewports are shown with synthetic
contrast weighted images: T1W, T2W, T2W FLAIR, PDW, Double IR (WM supp), and

PSIR
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5.1 Synthetic Contrast Weighted Images
The synthetic contrast weighted images are calculated using the measured
R1, R2 and PD values in combination with the selected TE, TR, TI and TI2
settings.

5.1.1 Display of Synthetic Contrast Weighted Images

A number of preset contrast weightings can be selected using the
right-click menu or keyboard commands. The available settings may
depend on your licensing.

Contrast Layout «Ctrl+R» Six viewports with contrast images are
displayed: a T1W, a T2W a T2W FLAIR, a PDW, a Double IR (WM supp) and a
PSIR. Default values for TE, TR and TI are listed in table 5.1. Table 5.2 shows
the defaults for DIR when a DIR enabled license is used.
Right-Click›T1W «1» A T1-weighted image is displayed in the active
viewport. In T1-weighted images, areas with low proton density are
weighted to enhance the image contrast between gray and white matter.
Right-Click›T2W «2» A T2-weighted image is displayed in the active
viewport.
Right-Click›PDW A PD-weighted image is displayed in the active viewport.
Right-Click›T1W FLAIR A T1-weighted Fluid Attenuated IR image is
displayed in the active viewport.
Right-Click›T2W FLAIR «3» A T2-weighted Fluid Attenuated IR image is
displayed in the active viewport.
Right-Click›STIR «4» A T2-weighted Short Tau IR image is displayed in the
active viewport.
Right-Click›PSIR «5» A Phase Sensitive IR image is displayed in the active
viewport.
Right-Click›PSIR (vessel) A Phase Sensitive IR image to highlight blood
vessels is displayed in the active viewport.
Right-Click›Double IR (WM supp) A Double IR image is displayed in the
active viewport, which suppresses both WM and CSF.
Right-Click›Double IR (GM supp) A Double IR image is displayed in the
active viewport, which suppresses both GM and CSF.

Note: The DIR menu items are only available if you have a license that
enables the DIR feature.
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Table 5.1: Default values for TE, TR, TI for the different synthetic contrast weighted im-
ages.

Image Type TE TR TI

T1W 10 ms 650 ms

T2W 100 ms 4 500 ms

PDW 10 ms 8 000 ms

T1W FLAIR 10 ms 2 500 ms 1 050 ms

T2W FLAIR 90 ms 15 000 ms 3 100 ms

T2W STIR 100 ms 15 000 ms 300 ms

PDW STIR 5 ms 15 000 ms 300 ms

PSIR 10 ms 6 000 ms 500 ms

PSIR (vessel) 10 ms 8 000 ms 10 ms

Table 5.2: Default TE, TR, TI and TI2 values for DIR for the supported field strengths.

Image Type
Field

Strength TE TR TI TI2

Double IR (WM supp) 1.5 T 100 ms 15 000 ms 420 ms 3 600 ms

Double IR (WM supp) 3.0 T 100 ms 15 000 ms 470 ms 3 750 ms

Double IR (GM supp) 1.5 T 10 ms 6 000 ms 700 ms 3 200 ms

Double IR (GM supp) 3.0 T 10 ms 6 000 ms 900 ms 3 600 ms

Double IR (fat supp) 1.5 T 5 ms 15 000 ms 280 ms 3 330 ms

Double IR (fat supp) 3.0 T 5 ms 15 000 ms 280 ms 3 330 ms

5.1.2 Adjusting the Image Contrast

SyMRI allows post-examination control of the contrast weighting in the
synthetic contrast weighted images. This is done by adjusting TE, TR, TI and
TI2. These options can be selected in the right-click menu, their toolbar icon
or keyboard shortcuts as indicated below. When adjusting the contrast
weighting by holding down the left mouse button, you can revert the
changes by pressing «Esc» before releasing the left mouse button.

Adjust TE «Q» TE is adjusted by moving the mouse while holding down the
left mouse button.
Adjust TR «W» TR is adjusted by moving the mouse while holding down the
left mouse button.
Adjust TR/TE «E» TR and TE are adjusted simultaneously by moving the
mouse while holding down the left mouse button.
Adjust TI «R» TI is adjusted by moving the mouse while holding down the
left mouse button. The option is available when the inversion pre-pulse is
activated.
Adjust TI-TI «T» TI and TI2 are adjusted by moving the mouse while holding
down the left mouse button. The option is available when the double
inversion pre-pulse is activated.
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Note: When the Adjust TI or Adjust TI-TI tool is selected, the mouse pointer
will become a red circle when passing over contrast weighted images where
the corresponding inversion pulse(s) are not active. Attempting to adjust TI
or TI2 for such an image will trigger a dialog box, asking you if you want to
activate the corresponding inversion pulse(s).

ROI Right-Click›Use ROI to Null Tissue The contrast weight of the image
will be adjusted, making tissue within the ROI appear black in the image.
This is done through an inversion pre-pulse with an optimized TI. To null
tissue of a certain type: place and adjust the size of a ROI so that the ROI
only includes tissue of the type you want to cancel out the signal from. This
will adjust TI in the shown image. In a DIR image, the TI used to null CSF will
be adjusted to keep nulling CSF, while the other TI will be optimized to null
the tissue in the ROI. Functions to draw a ROI are described in Section 5.3.
Also, see Section 7.3.1 (Use ROI to Null Tissue).
Right-Click›Image Settings›Inversion Prepulse «Ctrl+I» An inversion
pre-pulse will be activated in the image. The TI of the inversion pre-pulse is
displayed to the left in the view and can be adjusted using Adjust TI.
Right-Click›Image Settings›Double Inversion Prepulse Activate double
inversion pre-pulse in the image. The inversion times are displayed to the
left in the view and can be adjusted using Adjust TI-TI.
Right-Click›Image Settings›Enable PSIR When PSIR is inactivated,
negative values are visualized as the corresponding absolute value.
Negative values occur in images with an inversion pulse, for example PSIR.
In conventional MRI, only the absolute value can be displayed. Using SyMRI
the negative values can be shown by activating PSIR. When PSIR is
activated the string “PSIR (synthetic)” will be shown in the viewport HUD.
Right-Click›Image Settings›Enter Time Parameters Shows a dialog box
with input fields for each time parameter in the current viewport. Clicking
OK sets the values and closes the dialog box. Clicking Apply sets the values
but does not close the dialog box. Clicking Cancel reverts back to the initial
values before opening the dialog box and closes the dialog box.

5.1.3 Adjusting FLAIR Images

In a FLAIR image, fluid (CSF) is suppressed using a combination of an
inversion pulse and an inversion delay such that the fluid signal is nulled.
The combination of TR and TI used may vary across hospitals and it is
important to be aware of the differences.

Figure 5.2: Various setting of T2W FLAIR on an MS patient (post-Gd).
A: TR/TI = 15 000/3 100 ms, B: TR/TI = 15 000/2 850 ms,

C: TR/TI = 15 000/2 600 ms, D: TR/TI = 6 000/2 000 ms. The TE = 90 ms in all cases.
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In Figure 5.2, a number of examples are given for optimization of FLAIR
images: CSF is exactly nulled using the combination
TR/TI = 15 000/2 850 ms, resulting in very black CSF (Figure 5.2 B).
However, a longer TI at the same TR still has a reasonably suppressed CSF
but higher GM/WM contrast (Figure 5.2 A). A typical clinical FLAIR setting,
using a short TR for scan time reduction, leads to degradation of GM/WM
contrast but no change in scan time for synthetic MRI (Figure 5.2 D).
SyMRI annotates an image as FLAIR when the TI value is near the value that
suppresses CSF completely. For other TI values the image is annotated as IR.
Also, see Section 7.3.1 (Use ROI to Null Tissue).

5.1.4 Adjusting Double IR Images

In a Double IR image two tissues of choice are suppressed using a
combination of two inversion pulses and inversion delay times. For example,
WM, GM or fat can be suppressed simultaneously as CSF. In Figure 5.3a
number of examples are provided together with the suggested settings.

Figure 5.3: Example settings for Double IR at 3 T.
A: A DIR where white matter and CSF are suppressed using TE/TR = 90/15 000 ms,

TI1/TI2 = 470/3 750 ms (Female, 35 years),
B: A DIR for pediatric applications, using TE/TR = 10/8 000 ms,

TI1/TI2 = 900/3 950 ms (Male, 8 months) and
C: A fat-suppression DIR similar to a T2W FLAIR image with fat-suppression, using

TE/TR = 90/15 000 ms, TI1/TI2 = 250/3 200 ms (Female, 35 years).

To set two TI correctly is challenging and the “Use ROI to Null Tissue”
(Section 5.1.2) function is recommended.

5.1.5 Navigation Window for Contrast Images

The current contrast weighting of the image is displayed in the viewport in
two ways; as a navigation window at the left side of the viewport and as
text at the top of the viewport.
The navigation window (Figure 5.4) is displayed together with contrast
weighted images. In the navigation window, the contrast weighting of the
image is indicated by a yellow dot. When TR or TE is adjusted, use the
navigation window to see how the changes affect the contrast weighting. It
is also possible to adjust TE and TR by clicking on and dragging the yellow
dot.
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Figure 5.4: The circle in the
navigation window indicates
the contrast weighting of
the image displayed in the
viewport.

The text displayed at the top of the viewport changes depending on the
current contrast weighting. For spin-echo images, it can be T1W, T2W, PDW
or T1+T2 weight. If an inversion pre-pulse is active, the text will be IR, PSIR,
STIR, T1W FLAIR, T2W FLAIR or FLAIR. If two inversion pre-pulses are
activated, the contrast weighting will be DIR.
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5.2 SyMaps
The quantification maps in SyMRI display the measured values for tissue
properties per voxel in a dataset. The quantification maps for R1-relaxation
rate, R2-relaxation rate and proton density (PD) are the foundation of
synthetic MRI. In addition to these quantification maps the inverted
relaxation times T1 and T2 are available.

5.2.1 Display of SyMaps

The quantification maps described below can be selected with the right
click menu or the indicated keyboard shortcut.

Figure 5.5: The SyMaps layout contains the SyMaps for R1, R2 and PD.

Each parameter represented as a SyMaps has a certain range within which
it can be measured. This is known as the dynamic range of SyMRI. The
dynamic range of each parameter i listed in Table 7.2.

SyMaps Layout «Ctrl+F» Display the default SyMaps layout which consists
of 3 viewports with: R1-map, R2-map and PD-map.
Right-Click›SyMaps›T1 Map The T1 relaxation times are displayed in ms.
Right-Click›SyMaps›T2 Map The T2 relaxation times are displayed in ms.
Right-Click›SyMaps›R1 Map The R1 relaxation rate is displayed in s−1,
R1 = 1

T1
.

Right-Click›SyMaps›R2 Map The R2 relaxation rate is displayed in s−1,
R2 = 1

T2
.

Right-Click›SyMaps›PD Map The proton density is displayed in
percentage units (pu) relative to a reference value of 100 pu, which is the
proton density of water. Fat has higher proton density than water and is
therefore displayed with values above 100 pu.
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5.3 Region of Interest (ROI)
A ROI can be created to select an area in the image. Through the ROI, R1,
R2, PD and the signal intensity within the marked region can be analyzed.

5.3.1 Create and Adjust ROI

Create a ROI by placing the mouse pointer on a selected spot, push down
the left mouse button and draw desired shape and size, then release the
mouse button. To activate the tool for drawing ROI, use any of the
following alternatives:

Freehand ROI «F6» A ROI of free shape can be drawn. The ROI will be
closed by a linear segment when the mouse button is released.
Rectangle ROI «F7» A rectangular ROI can be drawn. The rectangular ROI
can be adjusted by marking one of the corners, holding the left
mouse-button and adjusting the ROI to the desired size.

5.3.2 Information in ROI

Information related to the ROI is displayed in the upper right corner of the
viewport (Figure 5.6), below the zoom and windowing. This block of text is
referred to as ROI Info.

Figure 5.6: ROI and related
information.

Two of the lines display the mean value and standard deviation for R1 and
R2 by default. These two lines can be changed to display T1 and T2 instead.

The following information is displayed:
Position: The center coordinates of the ROI relative to the image are

specified as “ROI [#,#]”. For the free-hand ROI, the center is that of
its bounding rectangle.

R1 or T1: Mean value and standard deviation of R1 or T1 within the ROI. For
T1-maps, T1 is displayed and for R1-maps, R1 is displayed.

R2 or T2: Mean value and standard deviation of R2 or T2 within the ROI. For
T2-maps, T2 is displayed and for R2-maps, R2 is displayed.

PD: Mean value and standard deviation of PD within the ROI.
Signal: Mean value and standard deviation of the voxel intensity. In

synthetic images this will correspond to the signal strength of the
simulated MRI signal.

Also, see sections 6.1, 6.4 and 6.7 for additional ROI operations available in
SyMRI NEURO.
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5.3.3 ROI Preferences

SyMRI supports several ROI per viewport and each ROI can be specific to a
certain slice.

Preferences›Multiple ROIs Enables the user to have more than one ROI
per viewport. Default is off. The active ROI has a solid outline while the
other ROI have dotted outlines. The appearance of an active and inactive
ROI can be seen in Figure 5.7.
When Multiple ROIs is off, a ROI is automatically deleted when a new ROI is
drawn in the same viewport. When Multiple ROIs is on, existing ROI remain
with a dotted outline.
Preferences›ROI per Slice Locks ROI to the specific slice where the ROI was
drawn. Default is off.
When ROI per Slice is off, a ROI remains visible when scrolling through the
slices. ROI Info is updated to display the statistics for the ROI in the
currently visible slice. When ROI per Slice is on, a ROI is only visible in the
slice where it was drawn. When scrolling to a different slice, the ROI will not
be visible. ROI Info will only be visible in slices with a ROI.

Figure 5.7: Two ROI in the same viewport. The upper ROI is active and therefore
displayed with a solid line outline. The lower ROI is not active and therefore

displayed with a dotted outline

Note: The information shown in the viewport is related to the ROI marked
as active. A ROI is activated by clicking on it with the left mouse button.
When a new ROI is drawn it is automatically marked as active. Which ROI is
active may also be chosen by pressing «Tab» or «Shift+Tab».

5.3.4 Functions on a ROI

Right-clicking on a ROI will display the ROI right-click menu. This menu
contains several operations for the ROI.

ROI Right-Click›Cut ROI «Ctrl+X» The ROI is copied and removed from
the viewport.
ROI Right-Click›Copy ROI «Ctrl+C» The ROI is copied.
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ROI Right-Click›Paste ROI «Ctrl+V» A previously copied ROI is pasted to
the active viewport.
The key command «Ctrl+V» must be used to paste the ROI into a viewport
without a ROI present. The key command «Ctrl+V» can also be used to
paste the ROI as text. The text can then be copied and pasted into SyMRI to
generate an identical ROI.
ROI Right-Click›Disable ROI «Backspace» The ROI is deleted from the
viewport.
ROI Right-Click›Show Plot The plot will be hidden or shown.
ROI Right-Click›Use ROI to Null Tissue See Section 5.1.2 (Adjusting the
Image Contrast). This function is automatically deactivated when changing
slice.
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5.4 Plots
With a ROI displayed in the image, a plot will automatically be displayed in
the lower right part of the viewport. The values of the voxels in the ROI are
plotted in the graph (Figure 5.8). The color indicates the amount of voxels
that have a certain combination of values. Red indicates a relatively high
number of voxels and blue a low number (Figure 5.9).

Figure 5.8: In the
plot all voxels within
the ROI are plotted.

The plot can be customized through the plot right-click menu.
There are three types of graphs are available in the plot right-click menu:
R1-R2, R1-PD and R2-PD plots. The plot’s axis and description change to
match the selected plot type.
There are two options available for the plot scale. One small plot scale
which is adapted for values typically encountered in the brain. The other
scale is a larger scale that provides a larger interval for the R1-R2, R1-PD
and R2-PD axes. The small scale is the default and recommended scale for
the brain anatomy, other anatomies will default to the large scale.

Figure 5.9: The plot
right-click menu
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5.5 Save and Load
Various types of images and image stacks can be saved from SyMRI to your
workstation or PACS. Which save and load options are available depends on
which deployment of SyMRI you are using.
CAUTION: Only the SyMaps and MDME source data can be re-opened by
SyMRI. The saved contrast weighted image stacks cannot be opened by
SyMRI, but can be opened by other DICOM image viewers.

WARNING: Observe that if the workstation is shut down or an error occurs
while data is saved, the resulting data is not reliable. Remove any saved
data and save again.
Note that for some deployments the save operation might only be par-
tially completed when it has been completed in SyMRI. For instance, the
Sectra PACS IDS7 deployment imports the saved data as a separate step.

Plug-In The Sectra PACS IDS7 starts the import when SyMRI initiates the save
operation, however even after SyMRI exits the Sectra PACS IDS7 might
still have images queued for import. If the Sectra PACS IDS7 crashes
after SyMRI has exited you should inspect the saved data. Please refer
to your Sectra PACS IDS7 documentation for details on how the Sectra
PACS IDS7 import works.

5.5.1 Save SyMaps

The File-menu contains options for saving SyMaps.
Note: This function only available when using SyMRI with an MDME dataset.

Note: SyMaps are usually encrypted. If this is the case, there will be one file
per slice. Encrypted SyMaps can be opened in a DICOM viewer, and will be
displayed as a T2W series. The encrypted SyMaps can be opened correctly
only in SyMRI.
MDME data for SyMRI typically contains over 300 images, while the
quantified SyMaps contains one or three images per slice and approximately
20 to 300 images in total.
Never delete the original dataset! Observe that the original dataset might
be needed to make reliable comparisons in future releases of the software.

Plug-In File›Save SyMaps (T1T2PD) to PACS A quantified image stack will be
saved to PACS as a separate series in the current examination.

StandAlone File›Save SyMaps (T1T2PD) to Local Folder... A quantified image stack
will be saved in DICOM-format to the selected folder on the local worksta-
tion. A DICOMDIR is created in the folder and the stack data is saved in a
subfolder. If a DICOMDIR file already exists it is updated.

Network File›Save SyMaps (T1T2PD) to PACS A quantified image stack will be
saved to the configured PACS via network as a separate series in the cur-
rent examination.
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5.5.1.1 Save Time

Before SyMRI is closed, saving the quantified SyMaps is recommended if you
want to load the dataset at a later time. This is recommended because it is
faster to load quantified SyMaps than starting from unquantified raw data
(MDME).

5.5.2 Save a Screenshot of the Workspace

The File-menu contains options for saving a screenshot of the workspace.

Note: The screenshot image cannot be opened by SyMRI but can be viewed
in other DICOM image viewers.

Plug-In File›Save Screenshot to PACS Screenshot of the SyMRI workspace is saved
to PACS as a new series in the current examination.

StandAlone File›Save Screenshot to File... Screenshot of the SyMRI workspace is
saved in DICOM format in the specified folder and given a specified file
name on the workstation. A DICOMDIR is created in the folder and the
file is saved in a subfolder. If a DICOMDIR file already exists, it is updated.

Network File›Save Screenshot to PACS Screenshot of the SyMRI workspace is saved
to the configured PACS via network, as a new series in the current exami-
nation.

5.5.3 Save Image Stacks

Note: The saved contrast weighted image stack cannot be opened by
SyMRI, but can be viewed in other DICOM image viewers.

Note: The format of the saved images is different depending on the color
setting. If color is on, the images will be saved as RGB-images. If color is off
the images will be saved as grayscale. See Section 3.4.2.

5.5.3.1 Save this Stack

The right-click menu for each viewport contains the option for saving the
stack shown in the current viewport to a new series. The stack retains the
settings from the viewport, e.g. windowing, contrast weighting and color
settings.

Plug-In Right-Click›Save this Stack to PACS Saves the stack to PACS as a new
series in the current examination.

StandAlone Right-Click›Save this Stack to Local Folder... Saves the stack in DICOM
format to the specified directory on the workstation. A DICOMDIR is cre-
ated in the folder and the stack data is saved in a subfolder. If aDICOMDIR
file already exists it is updated.
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Network Right-Click›Save this Stack to PACS Saves the stack to the configured
PACS via network, as a new series in the current examination.

5.5.3.2 Save all visible stacks

The toolbar and File-menu contains the option to save all currently visible
viewports as new series. If raw data has been opened, SyMaps are also
saved.

Plug-In File›Save all Visible Stacks to PACS Saves all visible stacks (along with
SyMaps if opened from raw data) to PACS as new series in the current
examination.

StandAlone File›Save all Visible Stacks to Local Folder... Saves all visible stacks
(along with SyMaps if opened from raw data) in DICOM format to the
specified directory on theworkstation. ADICOMDIR is created in the folder
and the stack data is saved in a subfolder. If aDICOMDIR file already exists
it is updated.

Network File›Save all Visible Stacks to PACS Saves all visible stacks (and SyMaps if
opened from raw data) to the configured PACS via network, as new series
in the current examination.
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6 Functions in SyMRI NEURO
In SyMRI NEURO, the functionality to perform brain tissue characterization
and brain volume measurement is available. Using the tissue properties R1,
R2 and PD the tissue partial volumes are automatically measured. In this
way, the intracranial volume (ICV) and the brain parenchymal volume
(BPV), as well as white matter (WM), gray matter (GM), cerebrospinal fluid
(CSF) and myelin correlated component (MyC) volumes are estimated. A
user mask is available to measure volumes of user-defined selection of
tissue.

CAUTION: The precision of these measurements depends on several
parameters, including sequence settings, scanner manufacturer and
field strength. Measuring the same patient again with the same
sequence and the same MR scanner has a high repeatability. Any
parameter change, however, such as changing the sequence or using
another MR scanner, may decrease the precision. The brain volumes
were validated at both 1.5 T and 3 T, but tolerance between scanners
can always lead to differences. It is therefore recommended to use
identical settings when doing longitudinal studies.

Figure 6.1: When SyMRI NEURO is started, six viewports are shown with synthetic
contrast weighted images: T1W, T2W, T2W FLAIR, PDW, Double IR (WM supp), and

PSIR. Use the keyboard accelerator «Ctrl+R» to return to this layout.
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6.1 The Intracranial Mask

WARNING: Before analyzing tissue volumes, the user shall verify that the
intracranial mask is anatomically correct. If the automatic generation
is unsuccessful, the mask must be corrected by the user using the ROI
functionality. Problems typically occur at the orbits and at the vertex
and base of the skull.

Figure 6.2: The intracranial
mask defines the ICV in
SyMRI NEURO. The red line
indicates the outside of the
ICV

The intracranial mask defines the intracranial volume in SyMRI NEURO. All
segmentation and volume calculations are applied to the voxels included in
the intracranial mask.
The intracranial mask is found by including WM, GM and CSF, followed by a
region growing algorithm to ensure a contiguous volume The edge of the
mask is defined at PD = 50, based on the assumption that the ICV edge is
halfway CSF (with PD = 100) and skull bone (PD = 0). Finally, the intracranial
mask is made 0.5 mm smaller to remove the dura mater. Note that the red
ICV edge line, as displayed in Figure 6.2, is plotted outside the ICV volume.

6.1.1 Adjusting the Intracranial Mask

The intracranial mask should be adjusted using the following steps:

1. Show the intracranial mask by selecting Intracranial Mask on the
right-click menu, or by pressing «I».

2. Scroll through all slices and verify that the intracranial mask is correct.

3. Add areas to the mask by drawing a ROI around the area. Add the
area to the mask by using Add to Intracranial Mask in the ROI
right-click menu, or by pressing «Insert» on the keyboard. Parts of
the ROI that extend outside the image are ignored when editing.

4. Remove areas from the mask by drawing a ROI around the area.
Remove the area from the mask by using Remove from Intracranial
Mask in the ROI right-click menu, or by pressing «Delete» on the
keyboard. Parts of the ROI that extend outside the image matrix are
ignored when editing.

5. Save the intracranial mask When the mask is correct, save changes
using Save Intracranial Mask in the File-menu. When the mask is
saved, the text below the segmentation table will be updated to:
“Intracranial mask last modified by ‘name of user’, ‘date’, ‘time’”.
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Plug-In The intracranial mask is not saved automatically when SyMaps are saved,
but will be recalculated when the SyMaps are opened. It is possible to
save the intracranial mask when SyMaps are opened. Once an intracranial
mask has been saved with the SyMaps, this mask will be automatically
loaded and displayed whenever the SyMaps are opened.

WARNING: The intracranial mask (Figure 6.2) corresponds to SyMRI
NEURO’s definition of ICV. The tissue segmentation and volume estima-
tion is performed for all voxels in the intracranial mask. Tissue outside
the mask will not be included in the estimation of tissue volumes.

6.1.2 Additional Functions for the Intracranial Mask

Menu items for the intracranial mask are found in both the File- and
Edit-menu:

File›Save Intracranial Mask The intracranial mask is saved and will be
loaded automatically the next time the examination is used. This menu
option is only available when a SyMaps dataset has been opened.

StandAlone The information is saved to a presentation state DICOM-object file in a
new series in the same folder the data-set was loaded from.
When saving SyMaps the intracranial mask is saved to the saved SyMaps
dataset.

Plug-In The information is saved to a presentation state DICOM-object in PACS in
a new series in the same examination as the loaded data-set.

Network The information is saved to a presentation state DICOM-object in the con-
figured PACS via the network in a new series in the same examination as
the loaded data-set.
When saving SyMaps the intracranial mask is saved to the saved SyMaps
dataset.

File›Load Intracranial Mask The last saved intracranial mask is loaded.
Edit›Recalculate Intracranial Mask The intracranial mask is regenerated
by the algorithm included in SyMRI NEURO.
Edit›Clear Intracranial Mask The intracranial mask is erased. All
calculated volumes are set to zero. This function is useful when the user
wants to define the brain from scratch.
Right-Click›Show Intracranial Mask Edge «H» Toggle show or hide the
intracranial mask edge.

WARNING: To create accurate segmentation results the complete skull
volume must be included in the intracranial mask. The intracranial mask
shall not be used to estimate the volume of specific parts of the brain
e.g. ventricles. To segment smaller regions of the brain the user mask
(Chapter 6.4) can be used.
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6.2 Tissue Segmentation
SyMRI automatically segments several tissue types. These include WM, GM,
CSF and MyC. The automatic segmentation is done on all voxels contained
within the ICV, defined by the intracranial mask.
The results of the tissue segmentations are presented in two ways, both as
total volumes presented in the segmentation table (Section 6.5) and as
segmentation maps (Section 6.3).

6.2.1 Brain Parenchyma and CSF Segmentation

Within the ICV, SyMRI segments tissue into four types, where each voxel
within the ICV contains partial volumes in the interval 0 to 100 % of the
voxel volume for each tissue type. The four tissue types in SyMRI’s
segmentation model are:

• WM , (Myelinated) White Matter

• GM , Gray Matter

• CSF , Cerebrospinal Fluid

• Non-WM/GM/CSF, tissue/fluid with characteristics which deviate
from WM, GM and CSF

Note: Tissue segmented as Non-WM/GM/CSF should not be assumed
to be pathological, it is merely the remainder of the voxel volume that
was not segmented as WM, GM or CSF.

The tissue definitions of WM, GM and CSF were defined using analysis of R1,
R2 and PD, as quantified by SyMRI. A neuroradiologist placed several ROI to
mark areas of pure WM, GM and CSF in brain datasets of a number of adult
healthy volunteers. Statistical analysis of the tissue properties within these
ROI was used to define Gaussian distributions of R1-R2-PD for each tissue
type, also referred to as tissue clusters.

WARNING: The tissue types are similar to but not identical to tissue ac-
cording to histological classification. For example, in very young chil-
dren, where white matter has not been fully myelinated, the tissue may
be segmented as GM instead of WM. This happens since WM is modeled
for myelinated white matter and the unmyelinated white matter more
closely matches the tissue properties of GM.

WARNING: No comparison with biological white matter, gray matter or
CSF has been made.

6.2.2 Myelin Correlated (MyC) Partial Volume Mapping

Separate from the segmentation maps for WM, GM, CSF and Non-WM/
GM/CSF, SyMRI can also display a segmentation map for Myelin correlated
component, MyC. This map has a high correlation to the partial volume of
myelin in each acquisition voxel. Typical values for MyC are 0–8 % in cortical
GM and 30–45 % in WM in adults. MyC is displayed in the image as a color
scale from 0 to 40 %, but the values may be higher. Use the ROI function to
verify MyC values in specific areas (see Section 6.7.1). In the human brain,
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MyC typically does not exceed 50 %. MyC is not linearly proportional to the
WM partial volume, e.g. MyC may vary in areas homogeneously segmented
as 100 % WM.
MyC is based on another segmentation model than WM, GM, CSF and
Non-WM/GM/CSF. The sum of the volumes of WM, GM, CSF and Non-WM/
GM/CSF add up to the total ICV, without including MyC. Real myelin
contains very thin layers of water, where relaxation occurs too fast to be
directly observed by the SyMRI acquisition. Owing to magnetization
exchange, however, the fast relaxing myelin water has an effect on the
surrounding, slower relaxing water, comprising axonal, intracellular and
extracellular water. Hence, the MyC values are based on the magnetic
exchange between myelin and the surrounding water. When myelin is
present, the observed relaxation rates of the surrounding water is higher,
and the observed PD is lower, than a situation where no myelin is present.
The MyC model contains four partial volumes, each with their own set of
relaxation rates and proton density parameters. The four partial volumes
are MyC, cellular partial volume, free water partial volume and excess
parenchymal water partial volume. The sum of these four partial volumes is
100 % for each acquisition voxel. An algorithm is used to determine the
optimal distribution of the four partial volumes to obtain the measured R1,
R2 and PD values for each voxel in the parametric maps. The MyC partial
volume has high R1 and R2 relaxation rates and low PD. The algorithm will
find a higher contribution of MyC in WM than GM, since the relaxation rates
in WM are higher than in GM, while the PD is lower in WM than in GM. Only
the compartment containing MyC can be displayed in SyMRI. More details
on the model for determining MyC are described in an open source journal
which is freely downloadable via
https://www.frontiersin.org/articles/10.3389/fneur.2016.00016/full.
Left in figure 6.3 a synthetic T2-FLAIR of an MS patient is shown, where
lesions are clearly visible. On the center image the MyC map is overlayed as
color. A ROI function can show local MyC values, the title displays the
volume per slice and in the segmentation table the entire volume is
summed. On the right the MyC map is shown again, without background
image and in B/W.
This image can be exported to PACS while keeping the numerical values.

Figure 6.3: Example of MyC mapping.

Note: There is a high correlation between MyC values and optical density of
histologically stained specimen with Luxol Fast Blue. Since the MyC
represents the total magnetic effect of myelin on the R1, R2 and PD of
surrounding tissue, however, it is not validated whether the partial volumes
of MyC and real myelin are identical.

CAUTION: Pathological changes in the brain tissue that causes R1, R2
and PD to deviate greatly from those found in non-pathological brain
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parenchyma may affect the MyC segmentation. One example of such a
change is severe edema where the relaxation rates approach those of
pure CSF.
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6.3 Segmentation Maps
Segmentation maps are used to visualize the tissue content in each voxel
within the ICV. As default, segmentation maps are displayed as overlays,
colored images that are displayed over contrast weighted images. The
contrast weighted image then acts as a frame of reference, while the
colored overlay displays tissue content. The overlays have different color
depending on which tissue they represent. Figure 6.4 displays five different
segmentation maps, displayed as overlays over contrast weighted images.
For WM/GM/CSF, the tissue maps model partial volume of healthy adult
tissue, which means that the maps saturate at 100 % for tissue
corresponding to pure WM/GM/CSF and (nonpathological) changes in e.g.
myelination within pure white matter are not displayed since they are all
mapped to 100 % in the WM map.
The segmentation maps (Figure 6.4) are displayed on a background, which
can be a contrast weighted image or solid black.

Figure 6.4: The segmentation layout consists of T1W images with MyC, WM, GM,
CSF and Non-WM/GM/CSF as overlays together with the Segmentation Table

6.3.1 Display Segmentation Maps

The segmentation maps are activated in the Right-Click menu or through
the associated keyboard accelerator.

Segmentation Layout «Ctrl+S» Display the default segmentation layout
which consists of 6 viewports with: MyC, WM, GM, CSF and Non-WM/GM/
CSF together with the Segmentation Table.
Right-Click›White Matter «7» The segmentation map for WM is displayed
as an overlay.
Right-Click›Gray Matter «8» The segmentation map for GM is displayed
as an overlay.
Right-Click›Cerebro-Spinal Fluid «9» The segmentation map for CSF is
displayed as an overlay.
Right-Click›Non-WM/GM/CSF «0» The segmentation map for tissue that
does not correspond to the definition of WM, GM or CSF is displayed as an
overlay.
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Right-Click›Myelin (MyC) «Y» The segmentation map for MyC is displayed
as an overlay.

When a segmentation map is visible, the total volume of the segmented
tissue within the current slice is shown in the top of viewport.
When a ROI is active and a segmentation overlay is visible, the volume
within the ROI is shown in the upper right corner of the viewport. See
section 6.7 for more information.
It is also possible to disable displaying the intracranial mask edge via menu
option Show Intracranial Mask Edge or short key «H».
When a segmentation map is visible, a gradient colorbar appears in the
upper right corner of the viewport. This bar shows how the color of the
segmentation map relates to partial tissue volume. See figure 6.5 for an
example of a colorbar.

6.3.2 Background Image for Segmentation

To view the segmentation maps on a linear scale from black to white, where
white is 100 % and black is 0 % tissue content, the color can be turned off.
The color can only be turned off after the background is disabled.
When the background is disabled it is also possible to window the
segmentation map in the same way as windowing a contrast image or a
quantitative map (see section 3.5.3). The colorscale in the colorbar is
updated when windowing.

Right-Click›Disable Background «Ctrl+B» Blank background is used. See
figure 6.5.
Right-Click›Image Settings›Color «C» Disable color

Figure 6.5: Example of
segmentation overlay on
blank background and a
colorbar.
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6.4 User Mask for User Defined Segmentation
The user mask gives the user the possibility to mark selected parts of the
image stack and add it to a user mask. The user mask can include tissue
both inside and outside the inracranial mask. The mask can be used to
segment the volume of specific tissues, lesions and anatomies. The user
mask is automatically displayed if SyMRI NEURO is started with a dataset
that contains a previously saved user mask.

6.4.1 Display the User Mask

The user mask is activated in the right-click menu.

Right-Click›Show User Mask «U» The user mask is displayed in the
viewport as an overlay.

6.4.2 Measuring Volume Using the User Mask

The main function of the user mask is to measure the volume of some user
defined region(s). The volume is calculated using the voxel volume,
including the underlying slice gap. The volume of the user mask can include
all, or part of each voxel. The user mask volume in the current slice is
displayed at the top of the view port(s) in which the user mask is displayed.
Partial volume can be added to the user mask by copying partial tissue
content from a segmentation map to the user mask (see 6.4.3). The partial
volume of the segmented tissue is then added to the user mask volume. For
example, if the partial volume of tissue in a voxel is 25 %, only 25 % of the
voxel volume is added to the user mask volume.
User mask that only includes part of the voxel volume is partially
transparent. More transparency represents lower partial volume.
Options for color and background are identical to those for segmentation
maps. See Section 6.3.2.

6.4.3 Create and Adjust User Mask

The user mask is created by adding or removing regions. This can be done by
adding or removing regions marked by a ROI, by adding segmented tissue
marked by a ROI, or by copying complete slices from a segmentation map.

6.4.3.1 Edit User Mask Using a ROI

When using a ROI to edit the user mask, areas and tissues can be added or
removed from the user mask via the ROI Right-Click menu. Start by placing
a ROI around the area you wish to change.

ROI Right-Click›Add to User Mask All voxels within the ROI are added to
the user mask. The total volume of each voxel is included in the user mask
volume.
ROI Right-Click›Remove from User Mask Removes all voxels within the
ROI from the user mask. The volume contributed by these voxels is removed
from the user mask.

It is also possible to copy tissue from a segmentation map.
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ROI Right-Click›Copy Tissue in ROI to User Mask - Scale Up All voxels
containing more than 1 % of the tissue in the segmentation map is added
to the user mask. The total volume of each voxel is included in the user
mask volume.
ROI Right-Click›Copy Tissue in ROI to User Mask - Partial Volume Partial
volumes are copied to the user mask.

Figure 6.6:
Copying with
partial volume
using a ROI with
segmentation
overlay

6.4.3.2 Additional Ways to Adjust the User Mask

It is possible to add all segmented tissue, in one or more slices, to the user
mask at once. This option appears on the right-click menu when a
segmentation map is visible.

Figure 6.7: Complete slices
of segmented tissue can be
copied to the user mask.

Right-Click›Copy Tissue to User Mask Copy all tissue in the visible map,
within a certain slice range, to the user mask. A dialog box appears, asking
you to select the slice range (Figure 6.7). By default, partial tissue volume is
added. Tick the box “Scale up partial volume to 100%” to include the total
voxel volume of all voxels with more than 1 % partial tissue volume.
Edit›Clear User Mask All voxels are removed from the user mask and the
user mask volume is set to zero.

6.4.4 Save and Load the User Mask

It is possible to save the user mask, and to load a previously saved mask.
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File›Save User Mask The user mask is saved. A dialog box appears asking
you to give the user mask a name. It is possible to save several user masks
with different names. The next time the data set is loaded in SyMRI NEURO,
a list of all saved usermasks listed in the DICOMDIR-file will be displayed. If
no other user mask is selected, or there is only one saved used mask, the
last saved user mask will be displayed.

StandAlone The information is saved to a presentation state DICOM-object file in a
new series in the same folder the data-set was loaded from.

Plug-In The information is saved to a presentation state DICOM-object in PACS in
a new series in the same examination as the loaded data-set.

Network The information is saved to a presentation state DICOM-object in the con-
figured PACS via the network in a new series in the same examination as
the loaded data-set.

File›Load User Mask The last saved user mask is loaded. Any current
changes will be replaced by the last saved mask. The last saved user mask
for a dataset will be loaded automatically when SyMRI NEURO is started.
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6.5 Segmentation Table
The segmentation table provides volumetric information of all segmented
tissue types in SyMRI NEURO, as well as the user mask. The total volumes
for the whole brain are always shown, and the table can be expanded to
show tissue volumes per slice.

Figure 6.8: In the
segmentation table,
calculated volumes of WM,
GM, CSF, Non-WM/GM/CSF
and MyC are shown. The
relative volumes, as a
percentage of brain volume
and ICV are also displayed.

Right-Click›Segmentation Table «6» Display the segmentation table in
the viewport.

In the segmentation table the following volumes are displayed:

• Sum (ml): Total volume of WM, GM, CSF, Non-WM/GM/CSF and MyC
in the intracranial mask.

• % BPV: Volumes of WM, GM, Non-WM/GM/CSF and MyC as
percentages of the total brain parenchyma volume. Note that the
percentages of WM, GM and NON sum up to 100 % while the
percentage of MyC is a percentage of BPV independent of the other
tissue types.

• % ICV: Volumes of WM, GM, CSF, Non-WM/GM/CSF and MyC as
percentages of the total intracranial volume. Note that the
percentages of WM, GM, CSF and NON sum up to 100 % while the
percentage of MyC is a percentage of ICV independent of the other
tissue types.

• Brain parenchymal fraction (BPF). The Parenchymal fraction is the
sum of the volumes for WM + GM + Non-WM/GM/CSF divided by the
total volume of the intracranial mask(

BPF = BPV
ICV

= ICV-CSF
ICV

= WM +GM +NON
ICV

)
.

Note: The percentage of MyC is not included in the calculation of BPF
since it is independent of the other tissue types that completely
partitions the content of ICV.

The name of the user that created or saved the intracranial mask is
displayed below the table together with time and date.

6.5.1 Displaying Volumes per Slice

The segmentation table can be expanded to show the tissue volumes for
each individual slice.

Segmentation table right-click›Show Slices expands the segmentation
table to show the tissue volumes in each slice.

• Slice Volume of WM, GM, CSF, Non-WM/GM/CSF and MyC per slice.
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6.5.2 User Mask in the Segmentation Table

If the user mask contains at least one voxel, a new column appears in the
segmentation table named “UM”. This column presents the user mask
volume in the same way as WM, GM, CSF, etc. Both the volume per slice,
total volume, and volume as percentage of ICV and BPV are displayed.

6.5.3 Exporting the Segmentation Table

File›Save Segmentation Table as text... The table with the segmentation
results is saved locally on the workstation as a text file. In the file, patient
name, examination ID and the versions of SyMRI used are saved.
File›Save Segmentation Table as Structured Report... The same
command as above, but the table is saved as a DICOM object using the
structured report format. Please refer to the DICOM Conformance
Statement for SyMRI for further (technical) details on this format.
Segmentation table right-click›Copy Segmentation Table «Ctrl+C»
Copy the segmentation table as text and lets you paste it into documents,
emails etc.
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6.6 Reference curves
The reference curves can be used to relate the brain segmentation volumes
of the patient to a reference value, established from healthy subjects.
The reference curves can be shown via the right-click menu, or using the
Reference Curves Layout icon. The layout shows reference curves for BPF,
MyCPF, ICV, BPV and CSF.
The patient’s value is indicated with a yellow dot. In the title of the
reference curve plot the value is displayed, together with the reference value
at that age and the standard deviations (sd) from the mean. See figure 6.9.

Right-Click›Reference Curves The reference curves sub-menu used to
change visible reference curve.
Right-Click on Axis Change scale for axis.

The reference curves are based on data from:

1. McAllister A, Leach J, West H, Jones B, Zhang B, Serai S. Quantitative
Synthetic MRI in Children: Normative Intracranial Tissue
Segmentation Values during Development. AJNR Am J Neuroradiol.
2017;38:2364-2372,

2. Vågberg M, Ambarki K, Lindqvist T, Birgander R, Svenningsson A.
Brain parenchymal fraction in an age-stratified healthy population -
determined by MRI using manual segmentation and three automated
segmentation methods. J Neuroradiol. 2016;43:384-391,

Figure 6.9: Screenshot of the reference curves layout.
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6.7 ROI in SyMRI NEURO
In addition to the functionality that the ROI has in SyMRI IMAGE (Section
5.3) the ROI is used for three functions specific to SyMRI NEURO:

1. To adjust the intracranial mask (Section 6.1.1).

2. To adjust the user mask (Section 6.4.3).

3. Measuring the volume of segmented tissue.

Figure 6.10: ROI
and related
information

6.7.1 Measuring the Volume of Segmented Tissue

When a segmentation map is visible, two new lines appear in the ROI Info
text. The first line starts with the name of the visible segmentation map,
e.g. WM or CSF. This line gives the mean and standard deviation of partial
volume segmented tissue content within the ROI, as a percentage of the
total ROI volume. The second line starts with Vol. and displays the volume
of segmented tissue within the ROI, followed by the total volume of the ROI.
The volumes are given in milliliters (ml).
If a user mask is visible, the volume information for the User Mask within the
ROI will be displayed in the same manner in ROI Info. In case both a user
mask and a segmentation overlay are visible, the volume information for
the user mask is displayed below the volume information for the segmented
tissue. See Figure 6.10.
Also note that the line displaying Signal is removed when the volume
information for a user mask or segmented tissue is displayed.
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6.8 Plots in SyMRI NEURO

Figure 6.11: The ROI-plot in
SyMRI NEURO.

The plots in SyMRI NEURO has the same functionality as in SyMRI IMAGE
(Section 5.4) with the addition of displaying the mean value of the defined
tissue types with a cross.

Plot Right-Click›Brain Cluster Reference clusters for CSF, WM and GM are
displayed.



PartIV
Important Information



7 Warnings
Read all information in this chapter, it contains important information
regarding safe usage of SyMRI.

7.1 Image Artifacts
The types of image artifacts appearing in conventional MR-images might
also appear in synthetic MRI. Image artifacts such as motion artifacts,
noise, folding etc. can appear for identical reasons. The effect on the
images, however, might be different as the signal sampling is different.

7.1.1 Motion Artifacts

Figure 7.1: Patient motion
might lead to folding and
ghosting.
A: T2W, B: FLAIR,
C: T2W with Non-WM/GM/
CSF-map

Just like conventional MRI, synthetic MRI is affected by movement.
Movement results in artifacts that decrease the quality of the images.
Synthetic images are made from several consecutive readings. Therefore,
motion artifacts might appear different compared to conventional images.
“Ghosting”-artifacts are similar to the ones seen in conventional images. In
most cases the segmentation algorithm performs well, apart from the area
affected by ghosting. Movement leads to fuzzy images with blurry edges.

WARNING: If the patient moves from her/his original position this will
lead to errors in the transitions between tissues in the R2-map and severe
measurement errors in the R1-map. This will result in unusable contrast
images and poor segmentation. Figure 7.1 displays a stroke patient who
has been moving during the examination.
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7.2 Deviations - Synthetic MRI
The synthetic contrast weighted images are intended to look similar to
conventional MRI images. There are however factors that make the
synthetic images different from conventional ones.

7.2.1 Black Blood

Figure 7.2: The signal from moving
blood is suppressed in Synthetic
images. For example arteries will not
be enhanced in a synthetic
T1W-image (to the right) after
contrast agent has been
administrated, as they would in a
conventional T1W-image (left).

The image acquisition for quantification suppresses the signal from moving
blood. This results in synthesized images with “black blood”-features.
Arteries will not be enhanced in the image, even if a contrast agent has
been administrated. Non-moving blood, caused by for example leakage,
will enhance the T1-value in synthetic images. This also applies when
contrast agent has accumulated within tissue.

WARNING: It is recommended to perform MDME acquisition prior to con-
trast agent administration.

7.2.2 Flow Sensitivity

Figure 7.3:
Hyper-intense
signal due to a CSF
flow jet.

Similar to conventional MRI, synthetic MRI may suffer from artifacts caused
by flow. Examples are a band of ghosting artifacts due to a large artery or a
flow jet in CSF (see Figure 7.3).

WARNING: Flow artifacts in particular are more pronounced for thinner
slices. The thinner the slice, themore likely and pronounced the flow arti-
facts will be. Flow in arteries may also cause an apparent Hyper-intense
Vessel Sign (also known as Arterial Hyperintensities) in FLAIR images.

7.2.3 Small Features Might Disappear

As in conventional MRI, small features will disappear if the resolution is too
low for the particular feature of interest.
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WARNING: In synthetic MRI, the calculations of R1, R2 and PD are
based on a model assuming that the relaxation in each voxel is mono-
exponential. Therefore, small structures not becoming the dominating
component in any voxel might disappear and not be visible in the syn-
thetic images.
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7.3 Functions Specific for Synthetic MRI
7.3.1 Use ROI to Null Tissue

WARNING: Selecting large areas where there is more than one tissue type
may cause the nulling algorithm to select a TI which corresponds to nei-
ther tissue type. For instance, selecting a large ROI containing both WM
and CSF in roughly equal proportions will cause incorrect nulling. See
Figure 7.4 for an illustration of the effects. Best results are achieved by
creating a ROI that contains only the tissue of interest.

Figure 7.4: Effects of ROI placement for the null tissue function. Note that in 7.4d
the caudate nucleus (nucleus caudatus) can be seen after the white matter has

been cancelled.

7.3.2 Quantitative Measurements

The quantitative measurements of R1 (T1), R2 (T2) and PD have been
verified in phantom studies. A set of phantoms with different combinations
of R1 and R2 were scanned and quantified with SyMRI, and the results were
compared to inversion recovery for R1 and multi-echo CPMG
(Carr-Purcell-Meiboom-Gill) for R2. For PD, a different phantom with
various concentrations of heavy water for was used. A good correlation was
shown for all parameters. The mean difference, standard deviation and
verification range (interval) for the quantitative parameters, as well as
different manufacturers and field strengths can be found in Table 7.1.

Note: Using SyMRI on MDME input data from Siemens 1.5 T scanners is not
yet 510(k) cleared by the US FDA and thus currently not available for sale in
the US unless limited to research or investigational use.

Table 7.1: Accuracy of SyMRI compared to gold standard on phantoms

Parameter Interval
Philips GE Siemens

1.5 T 3.0 T 1.5 T 3.0 T 1.5 T 3.0 T

R1 0.5 − 3.33 s−1 3 ± 6 % 9 ± 5 % 5 ± 6 % 7 ± 6 % −5 ± 9 % −2 ± 6 %

R2 2.5 − 25 s−1 11 ± 2 % 12 ± 3 % 11 ± 8 % 14 ± 7 % 13 ± 4 % 16 ± 3 %

PD 20 – 100 pu 8 ± 9 % 5 ± 12 % 3 ± 6 % 4 ± 6 % 6 ± 11 % 5 ± 10 %

The results from the phantom studies are exemplified in Figure 7.5.
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Figure 7.5: SyMRI quantitative measurements in comparison with gold standard quan-
titative measurements on phantoms for GE Discovery MR750 3 T.

7.3.2.1 Dynamic Range

The dynamic range of the measurements for the quantitative tissue
parameters are listed in Table 7.2.

WARNING: Values outside the dynamic range will be truncated.

Table 7.2: Dynamic Range for SyMRI.

Value Unit Min Max

T1 ms 250 4 300

R1 s−1 0.23 4

T2 ms 10 2 000

R2 s−1 0.5 100

PD pu 0 160

7.3.3 Segmentation

The segmentation in SyMRI is based on pre-defined clusters (WM, GM, CSF)
defined to represent white matter, gray matter and cerebro spinal fluid.
Observe that pathological tissue can have values corresponding to any of
the healthy definitions, in the same way healthy tissue might fall outside
the defined tissue definitions. Partial volume is calculated through a
simulation model (Bloch simulator) which aligns the values between two
tissue clusters to estimated partial tissue type.

CAUTION: An absolute comparison between different brains, or a brain
scanned at several points in time, must be made in comparable versions
of SyMRI. Present Release Notes will state whether changes have been
made compared to earlier versions of SyMRI.
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WARNING: In voxels with partial volume of known tissue and partial vol-
ume of bone, air or other tissue with low PD, the segmentation may erro-
neously classify the voxel as Non-WM/GM/CSF instead of partial volume
known tissue and partial volume Non-WM/GM/CSF.

WARNING: If there are mixtures of pathological tissues within a voxel the
tissue within the voxel might be partially misclassified as a result of par-
tial volume effects. For instance, a voxel containing two pathological
tissues, where the mix intersects a known tissue, may cause misclassifi-
cation as a partial volume of the known tissue.

WARNING: The administration of oxygen during MRI acquisition may in-
crease R2 relaxation rate in brain tissue and hence affect the segmenta-
tion analysis.

7.3.4 Factors Affecting the Volume Estimations

Verification and validation have been performed to evaluate the
repeatability of the volume measurements. The measurements are based
on pre-defined tissue definitions.

7.3.4.1 Accuracy

For volume estimations made in SyMRI, the volume for each separate voxel
is calculated as the product of the voxel base area in the slice and the slice
spacing (which includes the slice gap). The slice spacing is used instead of
the slice thickness to include the complete brain volume. Figure 7.6
illustrates how the spacing, thickness and gap are connected.

CAUTION: SyMRI estimates the tissue content in the slice gap based on
the two adjacent slices. The slice gap (Figure 7.6) shall be low, but not
less than 10 % of slice thickness, to avoid large approximations and
unacceptable cross-talk in the measurements. The recommended slice
gap is 25 % of the slice thickness. See section 7.4.1.1 for information
about the cross-talk and volume estimation trade-off.

Slice Spacing =
Slice Gap +

Slice Thickness

Figure 7.6: Illustration of the
relationships between Slice
Spacing, Slice Gap, and Slice
Thickness.
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7.3.4.2 Repeatability

To validate the repeatability of the segmentation method, in vivo
measurements was performed on 7 healthy subjects (age 32–48 years) that
were scanned using a GE 450W 1.5 T, a GE 750 3 T, a Philips Ingenia 1.5 T, a
Philips Ingenia 3 T, a Siemens Aera 1.5 T, and a Siemens Prisma 3 T scanner.
The subjects were scanned twice on each scanner, and were removed from
the scanner between the acquisitions. Not all subjects were scanned using
the Siemens scanners.

The repeatability of brain tissue volumes as a percentage of ICV, as well as
the repeatability of BPF are reported in Table 7.3. The repeatability reported
is the within-subject standard deviation, which means that the
repeatability coefficient can be obtained by multiplying the values by 2.77.

Note: Using SyMRI on MDME input data from Siemens 1.5 T scanners is not
yet 510(k) cleared by the US FDA and thus currently not available for sale in
the US unless limited to research or investigational use.

Table 7.3: Repeatability for SyMRI.

WM GM CSF NON MyC BPF

GE 450W 1.5 T 0.46 % 0.58 % 0.26 % 0.13 % 0.14 % 0.26 %

GE 750 3 T 0.53 % 0.57 % 0.15 % 0.17 % 0.17 % 0.15 %

Philips Ingenia 1.5 T 0.51 % 0.73 % 0.12 % 0.19 % 0.20 % 0.12 %

Philips Ingenia 3 T 0.55 % 0.79 % 0.15 % 0.17 % 0.19 % 0.15 %

Siemens Aera 1.5 T 0.47 % 0.55 % 0.13 % 0.17 % 0.13 % 0.13 %

Siemens Prisma 3 T 0.38 % 0.35 % 0.15 % 0.12 % 0.13 % 0.15 %

Siemens Sola 1.5 T 0.36 % 0.41 % 0.14 % 0.11 % 0.15 % 0.14 %

Siemens Vida 3 T 0.44 % 0.46 % 0.10 % 0.19 % 0.11 % 0.10 %

CAUTION: To acquire comparable volume measurements, it is important
that the same software version of SyMRI is used for all examinations.
Volumetric measurements performed by different versions of SyMRI may
be different due to changes in the software. Only compare datasets
that have been quantified and segmented by the same version of SyMRI.

CAUTION: SyMaps from the same dataset but generated using different
versions of SyMRI are not identical. Segmentation is performed base on
the combination of R1, R2 and PD in each voxel. Therefore, any
difference in the SyMaps may affect the segmentation and volume
measurement. In short, using SyMaps generated by different versions of
SyMRI may give different volumes even if they are both based on the
same MDME acquisition data, and even if both are loaded into the same
version of SyMRI.
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7.4 Additional Warnings
7.4.1 System Requirements

WARNING: SyMRI is only to be used according to the system requirements.
Any deviation from the system requirements may cause anything from
very subtle changes, to rendering datasets unloadable by SyMRI. At-
tempting to load data that was not generated as specified by the system
requirements violates the intended use of SyMRI.

7.4.1.1 Slice Gap

The slice gap affects the quantification of R2 (T2) and volume estimations
in segmentation.

CAUTION: The slice gap shall be greater than 10 % of the slice thickness
to avoid unacceptable cross-talk between slices. Cross-talk affects the
R2 (T2) quantification, and causes R2 to be overestimated. This will lead
to an overestimation of MyC content.
The recommended slice gap is 25 % of the slice thickness. This gap is
recommended since it provides a good trade-off between cross-talk and
volume estimation error.

If the slice gap is wide, the estimation error for tissue volumes within the
slice gap may increase. See Section 7.3.4.1.

7.4.1.2 Slice Thickness

The slice thickness affects the quantification, resolution of small features
and the risk of flow artifacts. The recommended slice thickness provides a
good trade-off between resolution and flow artifacts.
If the slices are thin, flow artifacts become more likely. For more
information, see Section 7.2.2.
If the slices are thick, the quantification will be affected by partial volume
effects. For more information, see Section 7.2.3.
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7.4.2 Follow-up Examinations Using Different Analysis Tools

WARNING: Different analysis tools use different models and methods
of volume estimation, including different definitions of tissues. This
results in systematic differences between different tools. Comparing
the volumes given by SyMRI to other analysis tools in follow-ups of
examinations can result in incorrect interpretation and/or conclusion. If
comparing the segmentation volumes given by e.g. NeuroQuant, based
on a T1W 3D acquisition, with the volumes given by SyMRI based on a 2D
MDME acquisition, the volumes may differ for several reasons. Amongst
others, the tissue definitions in NeuroQuant and SyMRI are different.
E.g., SyMRI uses partial volumes, while NeuroQuant assigns one tissue
type to each voxel.
In general, comparing data between different analysis tools should be
avoided unless justification for the validity of comparing the different
analysis tools can be provided.

SyntheticMR AB strongly recommend always using the same anal-
ysis tool to ensure that data from follow-up examinations can be
compared, and to perform the comparisons using applicable clinical
protocol and practice for follow-ups.

Note: SyMRI can only analyze tissue volumes on data from sequences that
are approved for use with SyMRI. For a list of approved sequences with
recommended sequence parameters please consult the System
Requirement List.

7.4.3 Character Encoding

WARNING: If a dataset with non-west European characters for any of the
textual information displayed in the HUD in SyMRI is loaded, this infor-
mation will not be displayed correctly. For more information about what
textual information is displayed in the HUD, see Section 3.2.1.1.

7.4.4 Anonymization Software

WARNING: SyMRI uses certain private DICOM tags to be able to load
datasets (see DICOM conformance statement). If anonymizing software
is used, check that these tags are preserved.
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7.5 Scanner Specific Warnings
7.5.1 GE

The following warnings only applies to usage on GE MRI scanners.

7.5.1.1 Anonymization

CAUTION: GE uses private DICOM tags to store a few acquisition
parameters required by SyMRI. Use anonymization tools provided by GE
to preserve these tags in anonymization. Datasets were the tags are
missing can not be opened by SyMRI.

The tags required by SyMRI are listed in the DICOM conformance statement.
If an anonymization tool not provided by GE is used, please confirm that the
required tags are preserved.

7.5.2 Philips

The following warnings only applies to usage on Philips MRI scanners.

7.5.2.1 Multiple Packages

Note that the System Requirement List requires that the scanner does not
generate multiple packages.
On Philips MRI scanners with Philips software version 4.x.y (only available
for 3T) or 5.1.x (available both for 1.5T and 3T) the scanner console will show
that it is going to generate multiple packages but it does not store this
information in the DICOM-objects; this means that it is not possible for
post-processing software, such as SyMRI, to detect if the scanner has
generated multiple packages after the scanning. Therefore, it is up to the
scanner operator to ensure that the scanner reports that it will not
generate multiple packages.
From Philips software version 5.2.x multiple packages will generate a
conflict in the exam card and scanning can not be started.

WARNING: Loadingmultiple package datamight cause unpredictable re-
sults which might not be apparently incorrect.

7.5.2.2 Slice Order

CAUTION: On Philips MRI scanners with Philips software version 4.x.y
(only available for 3T) or 5.1.x (available both for 1.5T and 3T) make sure
that slice order in the exam card is set to Ascending or Descending and
not Default or Interleaved.

The latter will cause quantification of T1 to oscillate between slices which
can be seen by selecting a large ROI and scrolling through the slices. The
curve for normal brain tissue in R1-R2-plot will then shift to the right/left
almost every other slice. From Philips software version 5.2.x the slice order
options Default and Interleaved have been removed.
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7.5.3 Siemens

The following warnings only applies to usage on Siemens MRI scanners.

Note: Using SyMRI on MDME input data from Siemens 1.5 T scanners is not
yet 510(k) cleared by the US FDA and thus currently not available for sale in
the US unless limited to research or investigational use.

7.5.3.1 Patient Position

CAUTION: Always position the patient so that the imaged anatomy is
placed at the ISO-center of the scanner. If the Patient is incorrectly
placed, the B1-field will be sub-optimal and the quantification may not
be performed correctly.

MRI scanners have optimal imaging conditions at the center of the coil, the
ISO-center of the magnetic field. Using the laser to position the patient
correctly will ensure optimal quantification, and thereby optimal image
quality in the synthetic images.



PartV
Appendix



8 Keyboard Shortcuts
A listing of all available keyboard shortcuts and their function available in
SyMRI.

macOS On macOS the following shortcut keys are different from Windows:

• instead of Ctrl.

• F13 instead of Insert.

Keyboard shortcut Function

1 T1W

2 T2W

3 T2W FLAIR

4 STIR

5 PSIR

Page Up Go to preceding slice

Up-arrow Go to preceding slice1

Page Down Go to succeeding slice

Down-arrow Go to succeeding slice1

Home Go to first slice

End Go to last slice

Ctrl+R Contrast Layout

Ctrl+F SyMaps Layout

A Auto Scale

Ctrl+Shift+I Invert Grayscale

C Color

Ctrl+Z Zoom in

Ctrl+Shift+Z Zoom out

Ctrl+P Bicubic interpolation

Ctrl+X Cut ROI

Ctrl+C Copy ROI

Ctrl+V Paste ROI
1 This shortcut is not available in SyMRI Plug-In since the Sectra PACS IDS7 host window uses it.
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Backspace Disable ROI

Tab Activate next ROI2

Shift+Tab Activate previous ROI 2

Ctrl+1 1 Viewport

Ctrl+2 2 Viewports

Ctrl+3 3 Viewports

Ctrl+4 4 Viewports

Ctrl+5 5 Viewports

Ctrl+6 6 Viewports

F4 Paging Tool

F5 Pan Tool1

P Pan Tool

F6 Freehand ROI

F7 Rectangle ROI

Z Zoom Tool

Q Adjust TE

W Adjust TR

R Adjust TI

T Adjust TI-TI3

X AutoROI Tool4

Ctrl+I Inversion Prepulse

Ctrl+O Open...

Ctrl+Shift+S Save all Visible Stacks to Local Folder...

Pan Tool is also available by holding the «Shift» key pressed.
Zoom Tool is also available by holding the «Ctrl» key pressed.
«S» and «F» can be used together with Adjust TR, Adjust TI or Adjust TI-TI
to decrease or increase the rate by which the time parameters are changed
when the cursor is moved. They can also be used to scroll faster between
slices and when adjusting the windowing.
When the User Mask feature is available the following keyboard shortcuts
can be used.

Keyboard shortcut Function

U Show User Mask

2 For Multiple ROIs
3 DIR-license is required.
4 AutoROI Tool-license is required.
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Ctrl+B Disable Background

With SyMRI NEURO the following keyboard shortcuts are also available.

Keyboard shortcut Function

Ctrl+S Segmentation Layout

Ctrl+C Copy Segmentation Table

6 Segmentation Table

7 White Matter

8 Gray Matter

9 Cerebro-Spinal Fluid

0 NON-WM/GM/CSF

Y Myelin (MyC)

I Intracranial Mask

H Show Intracranial Mask Edge

Ctrl+B Disable Background

Insert Add to Intracranial Mask

Delete Remove from Intracranial Mask

M Add to User Mask

Comma (,) Copy Tissue in ROI to User Mask - Scale Up

Period (.) Copy Tissue in ROI to User Mask - Partial Volume

Subtract (-) Remove from User Mask
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